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Preface

Welcome to the Oracle Network Logistics, Release 11i.

This Detailed Implementation Guide provides information and instructions about 
the implementation of the Oracle Network Logistics application.

This preface explains implementation considerations and processes is organized 
and introduces other sources of information that can help you.

Intended Audience
This guide is aimed at the following users:

� Product Implementation team (Oracle and Customer)

� Oracle and Customer Project Managers

� Technical Support Associates

� System Administrators (SAs), Database Administrators (DBAs), and others with 
similar responsibility.

This guide assumes you have the following prerequisites:

� Understanding of the product implementation processes.

� Knowledge of Oracle Network Logistics operation and services 

� Basic understanding of Oracle and Developer/2000

� Understanding of the interface protocol to each of the fulfillment elements 
(telnet, script)

� Background in SQL, PL/SQL, SQL* Plus programming
xi



Structure
This manual contains the following chapters:

� Considerations for planning

� Typical Release Dependencies

� Setting Profile options

� Considerations for Future Upgrades

Related Documents
For more information, see the following resources:

URLs
� http://crm.us.oracle.com

� http://products.us.oracle.com

Published Resources
� Oracle Network Logistics Concepts and Procedures

� Oracle CRL Concepts and Procedures

� Oracle Provisioning Implementation Guide

� Oracle Inventory User’s Guide

� Oracle Purchasing User’s Guide

� Oracle Assets User’s Guide

� Oracle Projects User’s Guide

� Oracle Payables User’s Guide

� Aim Documentation
xii



Conventions
The following conventions are also used in this manual:

Convention Meaning

    .
    .
    .

Vertical ellipsis points in an example mean that information not 
directly related to the example has been omitted.

. . . Horizontal ellipsis points in statements or commands mean that 
parts of the statement or command not directly related to the 
example have been omitted

boldface text Boldface type in text indicates a term defined in the text, the glossary, 
or in both locations.

< >  Angle brackets enclose user-supplied names.

[ ] Brackets enclose optional clauses from which you can choose one or 
none.
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Implementing Oracle Network Logistics

Considerations for Planning an Implementation Project
The following items are part of planning an Oracle Network Logistics 
Implementation:

n Overview of Oracle Network Logistics

n Application architecture

n Features and functions

n User roles

n Other considerations

Overview of Oracle Network Logistics

Network Logistics Defined
Oracle Network Logistics is a tracking system that integrates with and stores 
information collected from Inventory, Purchasing, Projects, Assets, and Payables. 
With Oracle Network Logistics, you can give users access to tracking information 
without allowing them access to sensitive processes related to assets and 
purchasing. You can also track inventory items after they have been installed and 
link financial transactions to the physical movement of equipment.

Understanding Inventory Item and Asset Tracking
To track inventory items and assets, Oracle Network Logistics must interact with 
several enterprise resource planning (ERP) applications. It sends to and receives 
messages from those applications about the status and location of the items you 
want to track.
                                                            Implementing Oracle Network Logistics 1



Considerations for Planning an Implementation Project
Overview of Message Flows in Oracle Network Logistics
Oracle Network Logistics acts as a hub, collecting information from and 
distributing information to the various other applications. In fact, Network 
Logistics is a systems integration pack that connects applications while residing in 
an interim layer between the applications and the database. For a technical 
overview of Network Logistics architecture, see Steps Before Implementation.

In the Overview of Message Flows in Oracle Network Logistics diagram, for 
example, when a field service technician enters a report that a piece of equipment 
has been placed into service, the Workforce Management System may send a 
message to Network Logistics. This message updates the status of the equipment to 
“In Service,” and gives its location parameters. Network Logistics then updates the 
message to the Fixed Assets System to create an asset at the new location.

Oracle Network
Logistics

Integration Pack

Oracle Purchasing

W orkforce
Management

Oracle Projects

Oracle Payables

Oracle Assets

Oracle Inventory

Oracle Inventory
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Considerations for Planning an Implementation Project
The Messaging Architecture in Oracle Network Logistics
The messaging architecture receives requests from external publishing systems in 
XML (eXtensible Markup Language) format. Based on the input requirements, the 
application updates the status and keeps a history of transactions for the tracking 
unit. Subsequently, the application publishes outgoing requests to the subscribing 
systems for further processing. The publishing and subscribing systems include: 
inventory, purchasing, accounts payable, fixed assets, project accounting, workforce 
management, and network inventory systems.

About Asset Creation
You must create an asset in Oracle Assets so that:

n Network Logistics can send and receive background messages about the asset.

n The system can track the asset from purchase to deployment.

n Depreciation can be accrued.

In Oracle Assets, you perform the Mass Additions concurrent process to create the 
asset.

Understanding Trackable Assets
An asset comprises a collection of items. The items may be trackable or not 
trackable. During implementation, items are designated as Network 
Logistics-trackable at the master level in Oracle Inventory. Oracle Network Logistics 
tracks the activity of the trackable items.

Understanding the Item Record
When an item is initially received via a purchase order, a receipt transaction occurs. 
The initial receipt transaction for a normal item creates a record for the item.

Note: A fatal error occurs if Network Logistics does not have an item 
record for a depreciable item that is received with a miscellaneous receipt. 
See Understanding the Error Log
                                                                 Implementing Oracle Network Logistics 3



Considerations for Planning an Implementation Project
Types of Transactions in the Item Record
After the initial receipt transaction, the item record records each transaction that is 
created as a result of moving the item. Possible transactions include: 

n Issue from inventory to project

n Return from project to inventory

n Miscellaneous issue

n Subinventory transfer

WMS Messages in the Item Record
The Workforce Management System (WMS) sends messages from field service 
personnel to Network Logistics whenever the status of the item changes. The status 
of an item may be one of the following:

Your enterprise may modify the name of any pre-defined status to fit your needs.

n In Inventory 

n In Transit

n In Depreciable Inventory

n Miscellaneous Issued

n Installed

n Out of Service

n Issued to project

n Retired

n In Service
Implementing Oracle Network Logistics 4                 



Considerations for Planning an Implementation Project
Items in Depreciable Inventory
When a depreciable item is received, Network Logistics:

n Creates an item record with a status of In Depreciable Inventory.

n Inserts a record in the interface table for Oracle Assets. The asset is created 
when the Post Mass Additions process is run.

n Stores the asset distribution ID in the item record

Depreciable inventory is designated at the subinventory level. Depreciable 
subinventories are expense subinventories that contain depreciable items. 

The cost assigned to depreciable assets is derived from the purchase order. When 
Accounts Payable processes the invoice, Network Logistics automatically adjusts 
the asset cost.

See also:

n Receiving Depreciable Items into Expense Subinventories

n Guidelines to Managing Negative Inventory

Understanding Move Orders
A move order transfers inventory:

n From one stocking location to another

n From a stocking location to a project

To create a move order, you manually create a move order requisition. Once the 
move order requisition is approved, it becomes a move order. If the organization 
does not require approval, the manual request automatically becomes a move 
order.

Network Logistics uses the following types of move orders:

n NL Move Order Issue to Project, to create a document for moving material 
from inventory to a project

n NL Move Order Subinventory Transfer, to create a document for moving 
material from one subinventory to another subinventory. See Understanding 
Subinventory Transfers.
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Considerations for Planning an Implementation Project
Parts of a Move Order
A move order comprises three parts:

n The Move Order Header holds the move order number, an optional description 
of the move order, and information to default to the individual move 
orderlines.

n The Move Order Lines are the actual move requests, including: the item 
number, requested quantity, completed quantity, the source and destination 
information.

n The Line Details are the inventory transactions that occur to fulfill a move 
order line, including: equipment code (CLEI), serial number, quantity moved, 
source and destination details (such as locators).

Move Order Approval Governed by Time-Out and Item Planner
At the organization level, three attributes–Move Order Time-out Period, Time-out 
Action, and Item Planner item–affect how move order requisitions are approved. If 
the move order requisition is not approved before the time-out period passes, 
Oracle Workflow sends a reminder notice to the item planner. If the move order 
requisition is still not approved within a second time-out interval, the requisition is 
automatically approved or rejected based on the Time-out Action setting. If no item 
planner is specified for the item, the requisition line is approved automatically.

Understanding Miscellaneous Transactions
Oracle Network Logistics supports the miscellaneous transactions–receipts and 
issues–used by Oracle Inventory. Each transaction in Inventory triggers a message 
to Network Logistics. Network Logistics does not adjust asset units to a number less 
than zero. If the transaction would cause a negative balance, Network Logistics 
adjusts only to zero

and creates no additional fixed asset distribution lines.

See also:

n When to Use Miscellaneous Receipts

n Understanding Miscellaneous Issues
Implementing Oracle Network Logistics 6                 



Considerations for Planning an Implementation Project
When to Use Miscellaneous Receipts
Use miscellaneous receipts to receive material without a purchase order number. 
Oracle Network Logistics uses the same process for performing a miscellaneous 
receipt as the process used in standard Oracle Inventory. You may also need to enter 
an equipment code (CLEI) in the Lot field, or a serial number.

For Normal Items
If no matching record already exists in the unit table, Network Logistics creates a 
record for the item. The record contains an item status of In Inventory and a 
transaction status of Complete. If the item already has a record with an item status 
of In Inventory, Network Logistics increments the quantity for the record.

For Depreciable Items
Network Logistics looks for and updates a record. If the record does not exist, a 
fatal error occurs.

In addition, the application determines the fixed asset location ID for the 
subinventory that is associated with the receipt transaction. If a distribution line 
already exists, Network Logistics adjusts the units of that line. Whether or not the 
item has a serial number, the asset cost remains unchanged.

For more information, see Oracle Inventory User’s Guide: Performing Miscellaneous 
Transactions and Oracle Assets User’s Guide: Defining Locations and Defining 
Distributions.

Understanding Miscellaneous Issues
In Oracle Network Logistics, the process for performing a miscellaneous issue is the 
same as the process used in standard Oracle Inventory. In addition, you need to 
enter the equipment code (CLEI) in the Lot field and, in most cases, a serial number.

Unit Status
For normal items, the status in the unit table must be In Inventory. For depreciable 
items, it must be In Depreciable Inventory.

For Normal Items with Serial Numbers
The application:

n Sets the item status in the unit table to Miscellaneous Issue.

n Sets the transaction status to Miscellaneous Issue.
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Considerations for Planning an Implementation Project
For Normal Items without Serial Numbers
The application:

n Decrements the quantity in the unit table record.

n Sets the transaction status to Miscellaneous Issue.

For Depreciable Items with Serial Numbers
The application:

n Determines the fixed asset location ID for the subinventory that is used in the 
miscellaneous transaction.

n Determines the fixed asset distribution ID and the corresponding asset in 
Oracle Fixed Assets.

n Sets the transaction status to Miscellaneous Issue.

Since depreciable items have companion asset records, the application also 
generates a workflow notification that advises you to fully retire the asset. When 
this transaction is completed in Oracle Fixed Assets, Network Logistics updates the 
item status in the unit table to Retired.

The retirement transaction is not generated automatically. You must manually 
perform the retirement transaction.

For Depreciable Items without Serial Numbers
The application:

n Determines the fixed asset location ID for the transaction subinventory.

n Determines the fixed asset distribution ID and the corresponding asset in 
Oracle Fixed Assets.

n Decrements the unit quantity of the asset distribution line. The asset cost is not 
adjusted.

For more information, see Oracle Inventory User’s Guide: Performing Miscellaneous 
Transactions and Oracle Assets User’s Guide: Defining Locations and Defining 
Distributions.
Implementing Oracle Network Logistics 8                 
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Understanding Subinventory Transfers
A subinventory transfer moves material inventory between subinventories. A 
subinventory is a unique physical or logical separation of material inventory, such 
as raw inventory, finished goods or defective material. All material within an 
organization is held in one or more subinventories.

A move order initiates a subinventory transfer. Oracle Network Logistics handles 
these transfers in the same manner that Oracle Inventory handles them.

For more information on how subinventory transfers are processed, see Basic 
Processing of Subinventory Transfers.

For information on move orders, see Understanding Move Orders.

Basic Processing of Subinventory Transfers
The way Network Logistics processes a subinventory transfer is based initially on 
whether or not the transferred item has a serial number.

Item with a Serial Number
Network Logistics searches the database for the From record associated to the item. 
This record must have a status of In Inventory or In Depreciable Inventory and a 
transaction status of Complete. Once Network Logistics locates the record, it 
updates the item’s subinventory in the From record.

Item without a Serial Number
Network Logistics searches the database for the From and To records. These records 
must have a status of either In Inventory or In Depreciable Inventory and a 
transaction status of Complete. Once Network Logistics locates the records, it 
updates the item’s subinventory in both the From and To records.

To and From Subinventory Status Must Be Compatible
A subinventory may have a status of either Depreciable or Normal. An item can 
only be transferred between subinventories that have the same status. Items cannot 
be transferred from Depreciable to Normal subinventories, or vice versa. If the 
status of the From subinventory does not match the status of the To subinventory, 
the application generates an error.

See also Subinventory Transfers of Depreciable Items.
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If a To Record Does Not Exist
If the application cannot find a To record, it creates a new record. The record has a 
status that matches the status of the From Record, either In Inventory or In 
Depreciable Inventory.

If a From Record Does Not Exist
If the application cannot find a From record for the item being transferred, it 
generates an error.

Subinventory Transfers of Depreciable Items
To transfer a depreciable item, at least two subinventories must exist which are 
designated as both depreciable and expense. The item number must be defined in 
Oracle Inventory.

When a depreciable item is transferred from one subinventory to another and the 
subinventories are in different physical locations, the transfer may require a change 
in the fixed asset distribution lines. In this circumstance, the changes that are made 
to the item record depend on whether or not the item has a serial number.

Depreciable Item with a Serial Number
The application:

n Retrieves the fixed asset location of the subinventory from which the item is 
being transferred (From inventory)

n Retrieves the fixed asset location of the subinventory to which the item is being 
transferred (To inventory)

n Updates the item record with the new fixed asset distribution ID

n Updates the item record with the subinventory to which it is transferred.

If the subinventory transfer of a depreciable item with a serial number does not 
require a change in the fixed asset distribution lines, the application updates the 
item quantity in the subinventory to which it is transferred.
Implementing Oracle Network Logistics 10                 
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Depreciable Item without a Serial Number
The application:

n Retrieves the fixed asset location of the subinventory from which the item is 
being transferred (From inventory)

n Retrieves the fixed asset location of the subinventory to which the item is being 
transferred (To inventory)

n Transfers the asset distribution to the To record

n _ Adjusts the quantities on both the From and To records

If no change in fixed asset distribution is required, the application updates the item 
quantities on the From and To records.

Understanding Inter-organization Transfers
An inter-organization transfer moves items between organizations. This transfer 
may be either a Direct or an In Transit transaction.

Direct vs. In Transit Transactions
In a Direct transaction, the shipping organization transfers the item into a 
subinventory in the receiving organization. For this reason, the application treats a 
Direct inter-organization transfer the same as a subinventory transfer.

For an In Transit transaction, the monetary value of the transferred item is 
deposited in an in-transit account and the inventory account of the shipping 
organization receives credit for the item. Upon receipt of the transferred item, the 
receiving organization must perform a receipt transaction to bring the item into its 
inventory. The receipt transaction credits the in-transit account and debits the 
inventory account of the receiving organization.

Inter-organization Transfers Tied to Oracle Inventory
Oracle Network Logistics uses the same process that Oracle Inventory uses to 
transfer materials between organizations. Before items can be transferred, items 
must be defined and subinventories must be created in Oracle Inventory.

If the organization from which the item is being transferred does not allow negative 
inventory balances, it must contain sufficient on-hand inventory for the transaction 
to occur.

See also Initial Step to Processing Inter-organization Transfers.
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Initial Step to Processing Inter-organization Transfers
If the inter-organization transfer is a Direct transaction, the application treats it as a 
Subinventory transfer.

If the inter-organization transfer is an In Transit transaction, the application 
searches the database for the From record associated to the item. This record must 
have a status of In Inventory or In Depreciable Inventory and a transaction status of 
Complete. If the item fails to meet these conditions, it generates an error message.

Next, the application determines whether or not the item to be transferred has a 
serial number.

See also:

n Inter-organization Transfers of Items with Serial Numbers

n Inter-organization Transfer of Items without Serial Numbers

n Understanding Inter-organization Transfers

Inter-organization Transfers of Items with Serial Numbers
To transfer an item with a serial number from one organization to another, the 
application:

n Updates the status in the item record to In Transit

n Updates the transaction status to Incomplete

n Determines if the Free On Board (FOB) type is Shipment or Receipt

To and From Subinventory Status Must Be Compatible
A subinventory may have a status of either Depreciable or Normal. An item can 
only be transferred between subinventories that have the same status. Items cannot 
be transferred from Depreciable to Normal subinventories, or vice versa. If the 
status of the From subinventory does not match the status of the To subinventory, 
the application generates an error.
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When the FOB Type is Shipment
The application changes the subinventory in the item record to that of the receiving 
organization as soon as the item leaves the shipping organization. When the item 
reaches its destination, someone enters a receipt transaction for the item. At this 
point, the application determines whether or not the item is depreciable.

If the item is normal—not depreciable—the application:

n Verifies that the receiving subinventory is not a depreciable subinventory

n Updates the record’s subinventory to that of the receiving subinventory

n Sets the transaction status to Complete

If the item is depreciable, the application verifies that the status of the receiving 
subinventory is In Depreciable inventory. Then, if the transfer requires a change in 
the fixed asset distribution lines, the application:

n Invokes an API that transfers the asset distribution line and returns a 
distribution ID

n Updates the item record with the new fixed asset distribution ID

n Updates the item record with the subinventory destination and transaction 
status Complete

If the subinventory transfer of a depreciable item with a serial number does not 
require a change in the fixed asset distribution lines, the application updates the 
item record with the subinventory destination and transaction status Complete.
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When the FOB type is Receipt
The shipping organization:

n Owns the material until it arrives at the receiving organization

n Holds the record in the source subinventory

If the item is normal—not depreciable—the application:

n Updates the record’s subinventory to that of the receiving subinventory

n Sets the transaction status to Complete

If the item is depreciable, the application uses the same steps as when the FOB type 
is Shipment and the item is depreciable.

See also:

n Understanding Inter-organization Transfers

n Initial Step to Processing Inter-organization Transfers

n Inter-organization Transfer of Items without Serial Numbers

Inter-organization Transfers of Items without Serial Numbers
If the item that is to be transferred has no serial number, Network Logistics:

n Creates a temporary unit record that contains the quantity being transferred 
and has a status of In-Transit

n Decrements the quantity of the From record

When the receiving organization enters a receipt transaction, Network Logistics 
searches the database for a To record. This record must have a unit status of In 
Inventory or In Depreciable Inventory and its transaction status must be Complete. 
If a To record does not exist, Network Logistics creates one.

The application then determines whether or not the item is depreciable.

To and From Subinventory Status Must Be Compatible
A subinventory may have a status of either Depreciable or Normal. An item can 
only be transferred between subinventories that have the same status. Items cannot 
be transferred from Depreciable to Normal subinventories, or vice versa. If the 
status of the From subinventory does not match the status of the To subinventory, 
the application generates an error.
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Completing Transfer of Normal items without Serial Numbers
To complete the inter-organization transfer, Network Logistics deletes the 
temporary record and increments the quantity in the To record.

Completing Transfer of Depreciable Items without Serial Numbers
Network Logistics retrieves the fixed asset locations for the From and To 
Subinventories. If the application had to create a To record for the item, then the 
receiving organization did not have a pre-existing asset record for the item. The 
application invokes an API that transfers the asset distribution lines to the receiving 
organization and then updates the distribution ID.

If a prior record exists but it requires a change in its fixed asset distributions, 
Network Logistics transfers the asset distribution lines by updating the item record 
with the new distribution ID.

In both cases, the application finally deletes the temporary record and adjusts the 
quantities on the From and To records according to the receipt transaction.

See also:

n Understanding Inter-organization Transfers

n Initial Step to Processing Inter-organization Transfers

n Inter-organization Transfers of Items with Serial Numbers

Understanding Adjustments
Use an adjustment to add a new record in Network Logistics or to correct an 
existing record. Use the adjustment window only when you need to update the 
Network Logistics records so that they match the corresponding records in Oracle 
Assets, Oracle Purchasing or Oracle Inventory.

An unexpected system error can interrupt communication between Network 
Logistics and other modules, such as Oracle Assets, Oracle Purchasing, or Oracle 
Inventory. As a consequence, Network Logistics records may not be created or may 
contain incorrect quantity information.

For example, you want to issue 10 items, but accidentally enter 19 on the

transaction. You cannot delete the record that contains the incorrect quantity, but 
you can make an adjustment to the quantity associated with an existing record in 
the Adjustment window. After you correct the record in the Adjustment window, 
you can also delete the associated message of the incorrect record that is in the Redo 
Log.
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See also:

n Making an Adjustment

n Understanding the Redo Log

Understanding the CLEI
The Common Language Equipment Identifier (CLEI) is a vendor-specific, 
10-character code. It is a standard used by the telecommunications industry for 
identifying and describing equipment. Because Oracle Network Logistics captures 
the CLEI code in the lot field, items that have a CLEI code must be set to full lot 
control. If an item has no CLEI code, it does not need lot control.

The supplier usually provides CLEI codes for the items you purchase. When 
performing transactions, you may select CLEI codes from a list of values, or you 
may enter new CLEI values directly into the Lot field.

See also Defining Vendor Equipment Codes (CLEI).

Overview of Retirements
The process that Network Logistics uses to retire and reinstate assets is the same as 
the process used in Oracle Assets, except that with Network Logistics you may only 
retire or reinstate whole assets.

Before you retire an asset, you must first take it out of service. If the asset being 
retired is in a depreciable subinventory, Network Logistics generates a 
miscellaneous issue transaction for the item and quantity. It then updates the item’s 
status to Retired.

Assets must have a status of retired before they can be reinstated. To retire or 
reinstate only part of an asset, the you must first retire the entire asset. You then 
reinstate the parts to remain in service as new whole assets.
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Guidelines to Managing Negative Inventory
Negative inventory balances are most often caused by inventory discrepancies, 
where the quantity or physical location of the item shown in the system is not 
correct. Such discrepancies are often the result of:

n A change in physical inventory that is not accompanied by a supporting 
transaction or the transaction is delayed

n A data entry error in the transaction

To determine if any items have negative on-hand balances, you can generate a 
report of only those items with negative on-hand quantities.

Negative Inventory Defined by Organization Setup
Each organization chooses whether or not to allow negative inventory balances as 
part of the organization setup. Some organizations choose to allow negative 
inventory balances so that the transactions may be entered into the system and 
negative quantities researched. Since you cannot physically have less than zero 
quantity on hand, some organizations choose not to allow negative balances 
because they misrepresent reality.

Handling Depreciable Inventory
If an organization has depreciable inventory, it must give careful consideration to 
whether or not negative inventory balances are permitted. If the organization’s 
requirements allow negative balances, then depreciable subinventories must be 
carefully monitored to make sure that the on-hand information for items being 
depreciated is accurate.

Another option is to create a separate organization for depreciable inventory where 
negative balances are not allowed. This option ensures that the on-hand balances of 
depreciating items do not fall below zero. The use of two organizations for 
inventory requires a higher volume of move orders and inter-organization 
transfers.

Physical Inventory Adjustments
A physical inventory occurs when a person verifies that units exist physically and 
that the quantities match the on-hand records in Network Logistics. Based on the 
results of physical inventory, Network Logistics supports adjustments that you 
make to your inventory balances. Depending on the type of inventory adjustment 
necessary, Network Logistics treats these adjustments like a miscellaneous 
transaction.
                                                                 Implementing Oracle Network Logistics 17



Considerations for Planning an Implementation Project
Overview of Network Logistics Requests
You can run the following reports, requests, and concurrent processes in Network 
Logistics:

n Network Logistics Assumed Loss Rate Report

n Network Logistics Bill of Lading Report

n Network Logistics Error Log Report

n Import Network Locations

n Network Logistics Redo Log Report

n PRC: Interface Payables Cost Adjustments to Assets

n PRC: Interface Payables Cost Adjustments to Projects

n Network Logistics Recovery Process

Understanding the Network Logistics Assumed Loss Rate Report
Use this report to see a detailed or summarized report of material transaction 
information for items that have been issued to projects but have never been placed 
in service. You can research the items on this report to determine whether they 
should be placed in service or returned to inventory.

See also: Requesting a Network Logistics Assumed Loss Rate Report

Understanding the Network Logistics Bill of Lading Report
Use this report to generate a bill of lading that may be used as a packing slip when 
you ship material to a project. You can use features in Network Logistics to ship 
material to project sites.

See also: Requesting a Network Logistics Bill of Lading Report
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Understanding the Network Logistics Error Log Report
Use this report to review a list of all transactions which had fatal errors. A fatal 
error can occur when:

n The item in a transaction has undefined attributes

n The transaction is a miscellaneous receipt, the item is depreciable and has no 
record in Network Logistics

n A record should exist and Network Logistics cannot find it

A transaction with a fatal error cannot be processed. Until the transaction is 
corrected, any subsequent transactions for the same item also generate a fatal error. 

The Error Log may also contain information about messages that are related to 
recoverable errors that are found on the Redo Log Report.

See also:

n Requesting a Network Logistics Error Log Report

n Network Logistics Redo Log Report

PRC: Interface Payables Invoice Cost Adjustments to Assets
Use this concurrent program to send invoice variances to Oracle Assets. This 
ensures that the asset records for depreciable items show a value that is as close to 
the actual purchase price as possible.

See also: Running a Concurrent Program

PRC: Interface Payables Invoice Cost Adjustments to Projects
Use this concurrent program to update projects with Invoice Price Variance (IPV) 
amounts. IPV is the difference between the amount on the invoice and the price on 
the purchase order line. This concurrent process ensures that the construction cost 
of the project is as close to the actual cost as possible.

See also: Running a Concurrent Program
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Understanding Network Locations
A network location, also known as a Common Language Location Identifier (CLLI), 
indicates a geographical location for an asset. Use the Import Network Locations 
request to bring CLLI codes from a legacy system into Network Logistics.

See also:

n Importing Network Locations

n Associate Network Locations to Fixed Asset Locations

Understanding the Item Summary Window
The Item Summary window displays a brief summary of the results of an inquiry in 
the Oracle Network Logistics responsibility. Each line in the window represents an 
item record. Use this window to see how items are distributed within the 
enterprise. Buttons at the bottom of the window link to more detailed information.

See also:

n Asset/Network Details

n Project Details

n Inventory Details

n Performing an Inquiry in Network Logistics

Understanding the Asset/Network Details Window
The Asset/Network Details window shows where a Network Logistics-trackable 
item is being used in the enterprise. Most items in this window are in service or 
installed as components of an asset. Buttons at the bottom of the window link to 
more detailed information.

This window appears when you click Asset/Network on the Item Summary

window.

See also:

n Performing an Inquiry in Network Logistics

n Understanding the Item Summary Window
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Understanding the Asset Details Window
The Asset Details window shows where a Network Logistics-trackable item is being 
used in the enterprise. Most items in this window are in service or installed as 
components of an asset. Buttons at the bottom of the window link to more detailed 
information.

n Performing an Inquiry in Network Logistics

n Understanding the Item Summary Window

Understanding the Project Details Window
The Project Details window displays information about the project that is using an 
item, including: item number, organization, serial number, quantity, location, install 
date, transaction/issue date, status, project number, task, lot number, vendor serial 
number, and reference._ Buttons at the bottom of the window link to more detailed

information. This window appears when you click In Process on the Item Summary 
window.

See also:

n Performing an Inquiry in Network Logistics

n Understanding the Item Summary Window

Understanding the Inventory Window
The Inventory window displays inventory information about a selected item, such 
as subinventory, lot number, revision, vendor serial number, and vendor name. 

Buttons at the bottom of the window link to more detailed information.

See also:

n Performing an Inquiry in Network Logistics

n Understanding the Item Summary Window
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Understanding the Transactions Window
The Transactions window displays the transaction history for a particular item. The 
particular details displayed may be related to Inventory Transactions, Project 
Transactions, or Asset Transactions.

See also:

n Performing an Inquiry in Network Logistics

n Understanding the Inventory Window

n Understanding the Project Details Window

n Understanding the Asset/Network Details Window
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Application Architecture
For implementation purposes, you can view Network Logistics as an integration 
application. Messages that pass back and forth between various enterprise resource 
planning modules tie those modules together. The following figure illustrates this 
architecture.

Oracle Network Logistics Architecture

Oracle
Purchasing

Oracle
Inventory

Oracle
Projects

Oracle
Assets

External
Work

Management

External
Network
Inventory

Oracle Network Logistics
Repository

Oracle Network Logistics Integration Pack

Oracle Service Delivery Platform Messaging Engine
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Features and Functions
This application supports all of the standard functions found in Oracle Inventory, 
Oracle Purchasing, Oracle CRL-Financials Enabled Assets, and Oracle 
CRL-Financials Enabled Projects, with the exception of those listed under Functions 
Not Supported by Oracle Network Logistics.

Oracle Network Logistics supports the following functions:
n Receipt of depreciable items into expense subinventories, without a project

n Receipt of normal items into operating projects and expense subinventories

n Cycle count and physical inventory adjustments

n Receipt of normal items into asset subinventories, without a project

n Issue of items to an operating project

n Installation of equipment from a workforce management system

n Subinventory transfers

n Inter-organization transfers

n Miscellaneous receipts and issues

n Placement of assets into or out of service

n Retirement and Reinstatement of assets

n Invoice cost adjustments to project expenditure lines and asset costs

n Item moves
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Functions Not Supported by Oracle Network Logistics
n Oracle Network Logistics does not support the following functions:

n Internal order issue

n Internal order transfer

n Work in process (WIP) assembly return

n WIP component return

n WIP component issue

n Sales order issue

n Return to vendor

n Return from vendor

n Receipt of a depreciable item directly to an operating project

n Receipt of a normal item into an expense subinventory

n Miscellaneous receipt of a depreciable item with a serial number

n Oracle Network Logistics does not support Oracle Project Manufacturing.
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User Roles
This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks.

Receiving Depreciable Items into Expense Subinventories

Prerequisites
At least one subinventory must exist which is designated as depreciable and 
expense. The item number must be defined in Oracle Inventory. The purchase order 
must exist in Oracle Purchasing and have a status of Approved.

Guidelines
Depreciable items must be received only into depreciable subinventories.

Depreciable items do not depreciate if they are received into an asset subinventory. 
To ensure that they are received only to depreciable subinventories, set up 
depreciable items with item/subinventory restrictions.

A subinventory may hold only depreciable or normal items, but not both. 

When you designate an expense subinventory as depreciable, an asset record is 
created for each item received into the subinventory. Depreciation occurs against 
those records. Normal items cannot be received into a depreciable subinventory.

On the other hand, if a subinventory is not depreciable, no asset records are created 
for the items in the subinventory. Depreciable items received into these 
subinventories never depreciate.

References
See the description of subinventory and item setups during implementation of 
Oracle Inventory.

Receiving Normal Items Directly into an Operating Project
A normal item is an item that is not depreciable. Use the following procedure to 
receive a normal item into an operating project
.

Note: A depreciable item cannot be received directly into a 
project. Instead, it must be issued from Inventory.
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Prerequisites
The purchase order must exist in Oracle Purchasing with a status of Approved. The 
purchase order line must include:

n The project and task numbers for the item

n The Expense destination type

The item number must be defined in Oracle Inventory. The project must be defined, 
with a status of Active. Both the destination type on the purchase order and the 
subinventory must be Expense.

Considerations
The application looks for an existing record for the item. If it locates a record and 
the receipt transaction has processed successfully, it updates the item record with 
the quantity received.

If the application does not find an existing record, it creates one for the receipt. The 
application sets the unit’s status to In Inventory and its transaction status to 
Complete.

Guidelines
Network Logistics does not support the receipt of depreciable items directly to a 
capital project.

Receiving Normal Items into Asset Subinventories
A normal item is any item that is not a depreciable item. Use the following 
procedure to receive a normal item into an asset subinventory.

Prerequisites
At least one subinventory must exist which has been designated as not depreciable 
and asset. The item number must be defined in Oracle Inventory. The purchase 
order must exist in Oracle Purchasing with a status of Approved.
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Managing Move Orders
In Network Logistics, you can:

n Create a Move Order

n Execute a Move Order

For more information about move orders, see Understanding Move Orders.

Creating a Move Order
Create a move order when you need to transfer inventory across subinventories or 
into a project account. Use the following steps to create a move order.

Prerequisites
Inventory setups, such as item and subinventory definition, must be complete. At 
least two transactions–Subinventory Transfer and Issue to Project–must also be 
defined. If you use an Oracle Workflow process to route move order requisitions for 
approval, the item must be assigned to an item planner.

Considerations
If approval is required, the item planner receives a Workflow notification that there 
are move order requisition order lines awaiting approval. The planner uses Oracle 
Workflow to approve the orders.

The item planner chooses Approve or Reject for each move order requisition line. If 
one requisition line on a move order is rejected, other lines of the same move order 
can be approved. Action defined on a move order line cannot be performed without 
approval.
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Executing a Move Order
After a move order is approved, you execute the move order by performing the 
action described on the approved lines. Use this procedure to perform the approved 
transaction.

Prerequisites
The move order must be approved.

Making an Adjustment
In the Adjustment window, you can either update the quantity in an existing record 
or create a new record.

See:

n Adding a New Record

n Updating the Quantity in an Existing Record

Adding a New Record
When a system error occurs, communication between Network Logistics and other 
modules, such as Oracle Inventory, Oracle Purchasing, and Oracle Assets may be 
interrupted. As a result, records for some items may be missing. Use the following 
procedure to add a Network Logistics record to reconcile the application with the 
records that exist in the other modules.

Steps
1. In the Network Logistics responsibility, navigate to Transaction > Adjustment.

As an alternative, if you are currently looking at the Adjustments window, click 
the New icon in the toolbar.

A blank record appears. You must enter information in the fields that are 
yellow.

2. Enter the appropriate Inventory Item number, Organization and Status and 
Quantity for with the new record.

If you enter a Status of In Inventory for the new record, only the Inventory tab 
appears. If you enter another status, the Inventory and Asset tabs both appear. 
When both tabs appear, you must enter information on both tabs.
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3. Enter the following information on the Inventory tab:

n A pre-existing serial number

n The revision of the item

n The subinventory from which the item should be taken

n The locator within the subinventory, if applicable

n The equipment code (CLEI) associated to the item

n The vendor name

n The vendor serial number

On the Assets tab, enter the asset number and asset location fields, if this 
information is available. When you enter this information, the other fields on 
the Assets tab are automatically populated with related information.

4. Click Apply to save your work.

A message asks you to confirm the new record.

5. Click OK to confirm.

Guidelines
Items that have serial numbers must have a quantity of either zero or one. Items 
that do not have serial numbers may have a quantity of zero or any number greater 
than zero.

Network Logistics links items and assets. When both the Inventory tab and the 
Assets tab are available in the Adjustments window, enter information on both tabs. 

Depending on the item attributes and status, some fields that are colored white on 
the Inventory and Assets tabs may require information. An error message appears if 
you try to save your work without supplying required information.

To create a complete record, enter as much information as possible, even in the 
fields that are optional.
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Updating the Quantity in an Existing Record
Use the following procedure to correct the quantity in an existing Network 
Logistics record.

Prerequisites
A Network Logistics record must exist for the item.

Steps
1. In the Network Logistics responsibility, navigate to Transaction > Adjustment.

2. Enter the appropriate Inventory Item, Organization and Status associated with 
the record.

3. Review the information in the Inventory, In Process or Assets tabs to verify that 
you have the correct record.

4. Enter the correct quantity.

The record for an item that has a serial number may have a quantity of 0 or 1 
only; a record for an item that has no serial number may have any positive 
number as its quantity.

5. Click Apply to save your work and commit the change.

If the item you selected has records in the Redo log, a Redo button appears. 
Click Redo to view redo records. In the Redo log, you can delete the records 
that are associated with the item. See Deleting a Record on the Redo Log.
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Deleting a Record on the Redo Log
The Redo log is a list of recoverable errors and messages that could not be 
processed. Some of these errors may be due to incorrect records. You can use the 
Adjustment window to correct the quantity for an incorrect record. After the 
adjustment, use this procedure to delete the associated record from the Redo log.

Steps
1. Following the procedure for Updating the Quantity in an Existing Record.

2. When the record has been updated, click Redo.

The Redo Log displays a list of incorrect records. Use the scroll bars to see the 
entire list.

3. To delete a record, click the checkbox to the left of the record and click Apply.

A message asks you to confirm the new record.

4. Click OK to confirm.

Performing an Inquiry in Network Logistics
Use the following procedure to review item records in Network Logistics that are 
give details about Inventory, Assets and Projects.

Prerequisites
All inventory setups, such as organization and item creation, must be completed.

See also: Understanding the Item Summary Window
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Submitting a Request
Use the Submit Request window to request one of the following reports and 
concurrent processes in Network Logistics:

n Network Logistics Assumed Loss Rate Report

n Network Logistics Bill of Lading

n Network Logistics Error Log Report

n Network Logistics Redo Log Report

n Network Logistics Recovery Process

n Import Network Locations

n PRC: Interface Payables Invoice Cost Adjustments to Assets

n PRC: Interface Payables Invoice Cost Adjustments to Projects

Requesting a Network Logistics Assumed Loss Rate Report
Use this procedure to generate a list of items that have been issued to projects but 
have never been placed in service.

Prerequisites
None.

See also: Viewing Request Results

Viewing Request Results
When you request a report, Network Logistics assigns a number to your request 
runs the request and stores the report. Use this procedure to view the report you 
requested.

Prerequisite
You must request a report and save the request ID number.
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Requesting a Network Logistics Bill of Lading Report
The bill of lading displays: the move order number; transaction request date; the 
ship-to location name and address; the project number; task number; line item 
number; item number; item revision; quantity requested and quantity shipped, both 
with totals for each item number; CLEI; serial number; and vendor serial number. 
Follow these steps to generate a bill of lading.

Prerequisites
None.

See also: Viewing Request Results

Guidelines
To print a bill of lading for a specific range of dates, enter a date in both Data 
Required From and Data Required To. If you do not enter any dates in these fields, 
the bill of lading only reports move orders for the current date.

If you enter a value for Task Number, enter a corresponding Project Number.

To keep the report results to a manageable length, enter data for as many of the 
parameter fields as possible.

Requesting a Network Logistics Error Log Report
Use this procedure to request a report that lists all fatal errors. For each error, the 
report displays: the item number, serial number, transaction date, transaction time, 
the error message text, and error description.

Prerequisites
None
Implementing Oracle Network Logistics 34                 



Considerations for Planning an Implementation Project
Steps
1.  In the Network Logistics responsibility, navigate to Requests > Run.

2.  Choose to run either a single report or a report set.

3. Choose Error Log Report in the Name field.

4.  In the Parameters window, enter information that defines your search.

n Start Date. Determines the first day in the range of days.

n End Date. Determines the last day in the range of days.

n Purge Data. To purge data from the Error Log after you have fixed the 
error.

5.  Click OK to close the Parameters window.

6.  Click Submit when you have finished defining the report.

The application assigns an ID number to your request. Use the ID number to 
find your request in the View Request form.

Guidelines
See also:

n Viewing Request Results

n Running the Recovery Process

Requesting a Redo Log Report
The Redo Log report shows all recoverable errors. For each error, the report 
displays: the item number, the serial number, transaction type, transaction date and 
time, and the text of the error message. Use the following procedure to generate a 
Redo Log report as part of the Recovery process.

Prerequisites
Suspend the message dequeuer before requesting a Redo Log report.
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Steps
1. In the Network Logistics responsibility, navigate to Requests > Run.

2. Choose to run either a single report or a report set.

3. In the Name field, choose Redo Log Report.

4. In the Parameters window, enter dates to limit the results returned.

n Start Date. Determines the first day in the range of days.

n End Date. Determines the last day in the range of days.

5. Click OK to close the Parameters window.

6. Click Submit when you have finished defining the report.

The application assigns an ID number to your request. Use the ID number to 
find your request in the View Request form.

See also:

n Running the Recovery Process

n Viewing Request Results

Guidelines
Disable the message dequeuer before you request a Redo Log report. This action 
prevents the addition of new messages to the list while you perform the Recovery 
process.

If you do not enter values for Start Date and End Date, the Redo Log displays all 
incomplete transactions.

References
See also:

n Understanding the Redo Log

n Understanding the Recovery Process

n Understanding the Message Dequeuer

n Oracle SDP Stop

n Requesting an Error Log Report
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Running a Concurrent Program
Network Logistics provides two concurrent programs for transferring invoice cost 
adjustments to Assets or Projects:

n PRC: Interface Payables Invoice Cost Adjustments to Assets

n PRC: Interface Payables Invoice Cost Adjustments to Projects

Use this procedure to run a concurrent program.

Steps
1. In the Network Logistics responsibility, navigate to Requests > Run.

2. Choose to run either a single report or a report set.

3. In the Name field, choose one of the concurrent processes.

4. In the Parameters window, enter information to define the items you want to 
include in the process.

5. Click OK to close the Parameters window.

6. Click Submit when you have finished defining the report.

The application assigns an ID number to your request. Use the ID number to 
find your request in the View Request form.

See also: Viewing Request Results

Importing Network Locations
A network location, also known as Common Language Location ID (CLLI), 
describes the exact geographical position of an asset. You may have a list of network 
locations in a legacy system. Use this concurrent request to import network 
locations from the legacy system into Network Logistics.

Prerequisites
None.
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Steps
1. In the Network Logistics responsibility, navigate to Requests > Run.

2. Choose to run either a single report or a report set.

3. In the Name field, choose Import Network Locations.

4. Click Submit.

The application assigns an ID number to your request. Use the ID number to 
find your request in the View Request form.

See also:  Viewing Request Results

Finding Personal Profile Values
In the Find Personal Profile Values window, you can search for the personal profile

values that have already been defined in other Oracle modules. Then use the 
Personal Profile Values window to display and make changes to your personal 
settings. Do not enter user values unless you require a setting that is different from 
the default setting.

Follow these steps to find and edit personal profile values used in the Network 
Logistics module.

Prerequisites
Profiles
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Steps
1. In the Network Logistics responsibility, navigate to Setup > Profiles.

The Find Personal Profile Values window opens.

2. Click [...} to open the list of values.

The Organizations window appears.

3. Enter CUN% in the Find field and click Find.

The Profiles window displays the profiles for Network Logistics.

4. Select the profile you want to edit and click OK.

The Find Personal Profile Values window displays the name of the selected 
profile.

5. Click Find.

The Personal Profile Values window opens and displays the selected profile.

6. Enter values in the User Value column to customize the user profile.

You cannot edit a gray field.

7. Select File > Save to save your changes.

Typical Release Dependencies
Oracle Network Logistics 11i is based on the foundation of the Oracle installed base 
that includes:

n Common Data Model

n Common Schema

n Technical Stack
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Setting Profile Options

Required Modules
Four modules must be installed and set up before you set up Network Logistics. 
Please consult the appropriate reference manuals for guidance in installing and 
setting up these modules:

n Oracle Inventory

n Oracle Projects

n Oracle Assets

n Oracle Purchasing

n Oracle Payables

n Oracle CRL-Financials

Required Item Definitions
After the modules listed in "Required Modules" have been installed, navigate to the 
System Administrator responsibility and perform the following tasks.

1. Define the following responsibilities. :

Note: * Responsibility names are suggested names.

Responsibility* Application

NL Inventory Link to Oracle Inventory

NL Projects  Link to Oracle CRL-Enabled Projects

NL Assets  Link to Oracle CRL-Enabled Assets

NL General Ledger  Link to Oracle General Ledger

NL Purchasing Link to Oracle Inventory Purchasing
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2. Define the following system profile options. 

3. Choose File > Save to save your work.

Considerations for Oracle Inventory Setup
This section discusses the setup steps in Oracle Inventory that have a bearing on 
how Network Logistics functions.

Define Organization Classifications
Oracle Network Logistics tracks those network inventory items which you have 
defined as Network Logistics-trackable. Each module that interacts with Oracle 
Network Logistics passes messages that contain specific information for all items 
that are marked as Network Logistics-trackable. For these messages to be sent and 
received successfully, the organizations you define must have these classifications:

n HR Organization

Use to associate employees, such as buyers and planners, with items within the 
organization.

n Inventory Organization

Use to define, maintain, transact, and have on-hand balances for item numbers.

n Project Expenditure/Event Organization

Allows Oracle Inventory to associate items assigned to project and tasks to a 
project clearing account, which collects the cost of that assigned material. Use to 
monitor the expenditures for a project and task by reviewing the account 
through Oracle Projects.

You must specify any additional classifications you need for your organization.

Profile Options Site level Value

CUN: Issue to Project Transaction Type (Issue to Projects)

CUN: NL Debug Log Directory Select the debug log directory

MO: Operating Unit
 Select operating unit for multiple 
organization implementation only

PA: Default Expenditure Organization name

GL: Set of Books name Select from corporate or tax books
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Define Organization Parameters
To ensure that the cost of material assigned to a project and task is passed to the 
project clearing account, go to the Inventory Parameters for the organization. Check 
Project Cost Collection Enabled on the Costing Information tab.

Define User-definable Transaction Types
Under the Inventory responsibility, you can define user-definable transaction types. 
At least two transactions– Subinventory Transfer and Issue to Project– must be 
defined. These transactions are used by Network Logistics to route move order

Guidelines to Defining items as Network Logistics Trackable
When an item is Network Logistics trackable, any activity for that item passes a 
message to Oracle Network Logistics for tracking. To make an item Network 
Logistics trackable, check the Network Logistics trackable checkbox on the 
Inventory item attributes tab when you define a master item.

When the Network Logistics Trackable attribute is controlled at the master level, 
items becomes Network Logistics trackable across all organizations.

In addition, follow these restriction guidelines when setting up Oracle Inventory:

n Define all Network Logistics items as inventory items.

If the Inventory Item checkbox is not marked, you cannot store or move the 
item.

n Enable Inventory Asset and Costing Enabled attributes for all normal items in 
Network Logistics.

These attributes let you enter and maintain costs for the items.

n Enable Item/subinventory restrictions for all items.

This lets you specify which subinventories an item may be stored in. These 
restrictions ensure that depreciable items are moved only into depreciable 
subinventories and normal items are moved only into asset subinventories.

n Do not use locator control for depreciable items.

This restriction assures compatibility with future Oracle Network Logistics 
functionality.

n Designate serial number control be at the Master organization level.

This ensures that serial number control for an item is the same across all 
inventory organizations.
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n Create separate subinventories for depreciable and normal items.

You can designate a subinventory as Depreciable during subinventory setup. 
The items in depreciable subinventories are depreciated. When a depreciable 
item is moved into a normal subinventory, it is no longer depreciated. On the 
other hand, normal items are not depreciated and so they must not be moved 
into depreciable subinventories. Do not move depreciable items into normal 
subinventories.

n Associate depreciable subinventories to a location.

Use the Location field in the subinventory setup to link the deliver-to location 
of the item with its asset location.

n Do not change an item’s depreciable status after transactions have been entered.

The depreciable status of an item is derived from the item attribute Asset 
Creation code.

n Do not change serial control for an item after transactions have been entered.

In Oracle Inventory, you may enter a miscellaneous issue transaction to remove 
all on-hand inventory, change the serial control attribute, then enter a 
miscellaneous receipt to restore the on-hand quantities. While this corrects 
on-hand inventory, it does not affect items that have already have transactions 
on record. As a result, records in Network Logistics are do not show the change 
in the serial control attribute.

n Do not change the Network Logistics Trackable attribute of an item after 
transactions for the item have been entered. 

Attribute changes are not applied to pre-existing transactions in the Network 
Logistics record. If you change the Trackable attribute of an item from No to 
Yes, transactions that occurred before the change have no record in Network 
Logistics. If you change the Trackable attribute of an item from Yes to No, 
Network Logistics no longer processes the pre-existing transactions.
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Understanding Inventory Setup
Some setup steps in Oracle Inventory have been changed to make use of 
features in Oracle Network Logistics. The additional setup steps for Inventory 
that require special information are:

n Define organization classifications

n Define organization parameters

n Set selected inventory items as Network Logistics-trackable

See also: Considerations for Oracle Inventory Setup

Defining Organization Classifications in Inventory
Oracle Network Logistics tracks those network inventory items for which you have 
defined organization classifications. Each module that interacts with Oracle 
Network Logistics passes messages that contain specific information for all items 
that are marked as Network Logistics-trackable. When Network Logistics receives 
these messages, it stores the information on database tables. When you open 
Network Logistics forms, you can see the information sent from other modules, if 
you have set up the following organizations:

n HR Organization

n Inventory Organization

n Project Expenditure/Event Organization

Use these steps to define inventory organization classifications.

Prerequisites
None

Note: For details on Oracle Inventory setup steps, please refer to 
the Oracle Inventory setup documentation.
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Steps
1. Navigate to the Organization Parameters window.

2. Enter the appropriate information in the header region of the window.

3. In the Organization Classifications region, enter the three organization 
classifications specified above. Add any other organization classifications that 
you need for your implementation of Network Logistics.

4. Choose File > Save to save your work.

References
When you assign the Inventory Organization classification to an organization that 
you have defined in Oracle Inventory, the organization can store and maintain 
inventory items.

When you assign the HR Organization classification to an organization you give 
yourself the ability to define employees, such as buyers and planners, and then 
assign the employees to items.

When you define the Project Expenditure/Event Organization classification, the 
Inventory module associates items that are assigned to projects and tasks with a 
project clearing account. You can closely monitor the expenditures for a project or 
task by reviewing this account through Oracle Projects.

Defining Organization Parameters in Oracle Inventory
When you issue material to projects and tasks, all costs are initially charged to a 
project clearing account. This account provides a convenient check point for 
tracking project costs.

The organization parameters described below ensure that the costs associated to a 
project or task are passed to the clearing account for the Inventory organization that 
has been set up to own network inventory items.

Use these steps to define organization parameters.

Prerequisites
You must define your organizations when you set up Oracle Inventory before you 
can define the organization parameters.
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Steps
1. Navigate to the Organization Parameters window.

2. Click the Inventory Parameters tab and enter:

n The Move Order Timeout Period

n The Move Order Timeout Action

3. Click the Costing Information tab and check Project Cost Collection Enabled.

4. Click the Other Accounts tab and enter the organization’s Project Clearing 
Account number.

5. Choose File > Save to save your work.

Setting Inventory Items as Network Logistics Trackable
Once you define your Network Logistics organizations, you must designate any 
items owned by those organizations as Network Logistics-trackable. This ensures 
that a message is passed to the Oracle Network Logistics module for each network 
inventory item.

Consequently, each transaction involving network inventory items sends a message 
to Network Logistics, which in turn routes a corresponding message to the 
appropriate inventory, workforce management, or accounting module.

For example, if you receive a switch into inventory as a Purchase Order Receipt and 
the switch is Network Logistics-trackable, then a message is sent to Oracle Network 
Logistics. When the switch is put into service, Network Logistics sends a message to 
the network inventory system to update the quantity on hand for that switch.

Use these steps for defining network inventory items as Network Logistics 
trackable.

Prerequisites
You must define an item master organization and at least one organization in 
Network Logistics.
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Steps
1. Navigate to the Master Item window.

2. Enter the appropriate information into the header region of the window.

3. Click the Inventory tab.

4. Check Inventory Item.

Stockable and Transactable are checked by default.

5. Check Network Logistics Trackable.

6. Enter or select information in the remaining fields of the window.

7. Choose File > Save to save your work.

Guidelines
Refer to Oracle Network Logistics Module Integration Setup for other important 
information about setting up items in Network Logistics.

Considerations for Oracle Assets Setups
The definitions of the Asset Locator and Asset Category key flexfields must be 
compatible with the segments of the expenditure item descriptive flexfield defined 
earlier.

If you use group depreciation and Oracle CRL- Financials, you must define the 
Group Asset and Super Group key flexfields. The recommended values are shown 
in the following table.

In addition, be aware of the following:

n Do not change or delete the link between the deliver-to and asset location once 
an asset has been created.

Use the Locations form in Network Logistics to initially link deliver-to and 
asset location. After this initial link is created, changing or deleting the link 
could corrupt the asset record.

Application Key Flexfield Suggested Segment Values

Oracle Assets Group Asset  (1) City, (2) Network Element

Oracle Assets Super Group (1) Region, (2) Product Line
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n When assets are created through Network Logistics, the asset key flexfield 
value is null.

If you want need Network Logistics to automatically populate this value, you 
must customize the application.

Considerations for Oracle Projects Setup
When you a depreciable item is received in Inventory, the transaction creates an 
item record with a status of In Depreciable Inventory in Network Logistics. The 
transaction information is automatically sent to an asset interface table in Oracle 
Assets, where an asset record is created the next time someone runs the Mass 
Additions process. Multiple assets can be created for any combination of project 
and task.

Define a Descriptive Flexfield for Expenditure Items
The expenditure item descriptive flexfield is optional. It provides a way to view the 
attributes or grouping method values of an item.

1.  Define this descriptive flexfield for Oracle Projects and call it Expenditure 
Items.

2.  Check the Displayed checkbox for all five segments in the flexfield.

3.  Refer to the following table to define the five segments in the flexfield.

Name  Window Prompt Column Value Set

Grouping 
Method 1

Grouping Method One ATTRIBUTE8 NL Asset Category 
(FA_CATEGORIES 
table)

Grouping
Method 2

Grouping Method Two ATTRIBUTE9 NL Location (FA_
LOCATIONS table)

Grouping
Method 3

Grouping Method Three ATTRIBUTE10 PA Product Value 
(PA_SEGMENT_
VALUE_LOOKUPS 
table)

Item number  Item Number ATTRIBUTE6  50 chars (no 
validation)

Serial number Serial Number ATTRIBUTE7 50 chars (no 
validation)
Implementing Oracle Network Logistics 48                 



Setting Profile Options
In addition, heed these restriction guidelines when setting up Oracle Projects:

n Issue Network Logistics-trackable items only to Capital-type projects.

Oracle Projects cannot create assets in Oracle Assets from projects that are not 
the Capital type. If items are issued to projects of either Contract or Indirect 
type, then Network Logistics does not have a record of the asset ID. When you 
generate asset lines, no asset lines are generated for those items that do not 
belong to the Capital-type project.

n Issue Network Logistics-trackable items only to tasks that can be capitalized.

You can generate asset lines only on tasks that have been capitalized.

n Do not send installation and in-service messages against projects that have a 
Closed status.

Network Logistics does not validate whether or not the project has a Closed 
status. It continues to change the item status to Installed or In Service. However, 
you cannot generate asset lines against a closed project.

Setting Up Asset Creation Grouping Methods for 
Project Expenditure Items
An asset can be created before a project is completed. The asset must be associated 
to location and asset category information. CRL-Financials Enabled Projects can 
send the associated information to Oracle Network Logistics and CRL-Financials 
Enabled Assets. In turn, Oracle Network Logistics uses this information to update 
the assets and the network inventory system.

Use this procedure to ensure that the assets created in CRL-Financials Enabled 
Projects are associated to the required location and asset category information.

Prerequisites
None.
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Steps
1. In the CRL Projects Manager Responsibility, select Project > Asset Creation.

2. Select values in the Asset Naming Convention window.

For Location and Category, the Grouping Element Number must correspond 
with attribute 8, 9, or 10, depending on which attribute was chosen to indicate 
location in the system-level descriptive flexfield setup. See Considerations for 
Oracle Assets Setup.

3. Choose File > Save to save your work.

Note: For details on Oracle Projects and Oracle CRL-Financials Enabled Projects 
setup steps, please refer to the setup documentation for those products.

Considerations for Oracle Purchasing
When an organization receives an item, the subinventory material account is 
debited and the AP accrual account is credited. When the item is issued to a project 
and the cost collection process is run, the project clearing account is debited and the 
project’s account is credited.

To ensure that Network Logistics picks up the Project clearing account for the 
charge account of purchase order, modify Oracle Account Generator as follows:

PO charge account = project clearing account

This modification ensures that the project clearing account used in the organization 
matches the credit account generated by auto-accounting for receipt transactions. 

In addition, heed the following restrictions when setting up Oracle Purchasing:

n Set the match approval level to at least three-way matching.

Network Logistics uses purchase order and invoice data to determine and 
adjust costs. Three-way matching ensures that the purchase order quantity, the 
receipt quantity, and the invoice quantity all match. You can also set the match 
approval level higher, to four-way matching.

If your organization’s default matching method is less than three-way, update 
the matching level setting on the purchase order itself.
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n Assign an asset category to Network Logistics trackable items.

The asset category must not be an expense category and must belong to the 
same Assets book as the book used by the Profile Option CUN:FA Book Type 
Code. See Setting Profile Options.

Network Logistics uses this purchasing item attribute to derive the asset category it uses when it creates asset records. Set control of this attribute at the master organization level so that the asset category for an item is the same across all inventory organizations.

n To receive normal items directly to a project, set the destination type on the 
purchase order as expense.

When you are enter the purchase order, do not check the Accrue on Receipt flag 
in the shipments window.

Additional Setup Restrictions
In addition to the restrictions discussed in the sections for Oracle Inventory, Oracle 
Assets, Oracle Projects, and Oracle Purchasing, heed the following restrictions for 
other related modules:

n Define the quantity tolerance in Oracle Payables as zero.

The method Network Logistics uses to calculate invoice price variance (IPV) 
requires this restriction. However, price tolerances are permitted.

n Do not modify the Oracle Account Generator logic for deriving the depreciation 
expense account.

The depreciation expense account is derived from the book type (corporate or 
tax) and the asset category. Network Logistics assumes that the depreciation 
expense account remains unchanged as a result of subinventory or 
inter-organization transfers.

Note: Invoice-only purchases are not supported in this release of 
Oracle Network Logistics.

Note: Use a standard setup for Oracle Purchasing, Oracle Assets, 
Oracle General Ledger, Oracle Payables, and the Oracle Human 
Resource Management System (HRMS). For detailed setup 
information on all of these applications, except Oracle HRMS, 
consult the appropriate documentation set. For detailed setup 
information on Oracle HRMS, please refer to the Oracle HRMS 
implementation documentation appropriate for the country where 
the application is being installed.
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Oracle Network Logistics Module Integration Setup
After Oracle Inventory, Oracle Projects, Oracle Assets, and Oracle Purchasing have 
been installed and set up, set up Network Logistics. During the integration setup of 
Oracle Network Logistics, you determine:

n What information displays when you query the system

n How network inventory locations map to asset locations in CRL-Financials 
Enabled Assets

n How messages are queued in the message history log and where the log is 
stored

The setup steps for the Oracle Network Logistics module are:

n Define Equipment Codes (CLEI)

n Set Profile Options

n Associate Network Locations to Fixed Asset Locations

Defining Equipment Codes (CLEI)
Equipment codes are Common Language Equipment Identifier (CLEI) codes. You 
can enter CLEI codes at the time you receive an item, or you pre-define the CLEI in 
the Define Equipment Codes window.

To pre-define the vendor equipment codes, use these steps.

Prerequisites
Items and organizations must be defined.

Steps
1.  From the Network Logistics responsibility, choose Setup > Equipment Codes.

2.  In the Equipment Codes Setup window, enter the item number for which you 
are creating a CLEI.

3.  Enter the organization that uses the CLEI.

4.  Enter the CLEI number for the item.

5.  Enter the name of the item manufacturer.

6.  Enter the Model number for the item.

7.  Choose File > Save to save your work.
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Guidelines
If two or more organizations use different lot control settings, you have to create 
multiple records for the same CLEI number and assign one of the CLEI records to 
each organization.

You cannot update an existing CLEI record. At some future date, if you decide to 
purchase the item from a different manufacturer, you must first enter an expiration 
date for the original CLEI record, then create a new record with the new CLEI.

Setting Profile Options
These profile options determine how messages are dequeued, where the history file 
for debugging is located, and where event notifications are sent. Use the Personal 
Profile Values window to make changes to your personal settings. Do not enter user 
values unless you require a setting that is different from the default setting. 

Use these steps to set profile options.

Steps
1. From the Navigator for the Network Logistics responsibility, choose Setup > 

Profiles.
2. In the Profile Name field of the Find Personal Profile Values window, enter 

CUN% and click Find.

3. Select Issue to Project from the Profile Values window and click OK.

The Personal Profile Values window displays the following profile options that 
you can define.
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Associating Locations to Fixed Asset Locations

You must associate inventory locations to asset locations in Oracle CRL-Financials 
Enabled Assets. Oracle Network Logistics displays this information for items in 
response to a query. Use the Network Logistics Locations window to associate 
either an HR location– such as a ship-to site or office– or a network location, also 
known as a Common Language Location ID (CLLI), to a fixed asset location.

Prerequisites
HR locations must be defined.

Oracle Network Logistics Module Profile Option Settings

Profile Name Default Value Profile Option Function

CUN: Debug Log 
Directory 

/usr/tmp Sets the file and directory of the 
debug log file.

CUN: Debug Option Y Enter Y (yes) or N (no) to control 
the debugging function for the 
message dequeuer.

CUN: FA Book Type Code Defines the asset book against 
which Network Logistics creates 
assets and accrues depreciation.

CUN:Issue to Projects 
Transaction Type 

Defines which transaction type 
represents the Network Logistics 
Issue to Project.

CUN: PA Expenditure 
Type 

The default expenditure type, 
used when material is issued to a 
project.

CUN: Workflow 
Notification Recipient

SYSADMIN Defines who receives error 
notifications or alerts about the 
Oracle Network Logistics module 
messages.

Note: Use either the HR Location or the CLLI to associate 
inventory to the fixed asset location. Do not use both values with 
one fixed asset location
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Steps
1. In the Network Logistics responsibility, choose Setup > Locations.

The Network Logistics Locations window opens.

2. Choose either an HR Location from the list of values, or enter a CLLI code in 
the CLLI field.

Do not associate both options with one fixed asset location.

Use this window to create CLLI locations. HR locations have already been 
defined, so the list of HR Locations contain values.

3. Enter a value in the Asset Location field.

4. Check Enabled to activate this association.

When an association becomes invalid, due to an asset going out of service or 
being retired, you can remove the check to inactivate this association.

5. Choose File > Save to save your work.

Guidelines
You can use this window to disable or enable mappings:

n When items are temporarily moved or taken out of service

n For different sites or for different users

Administering Network Logistics
This topic group provides task-based procedures that are required for ongoing 
system maintenance and includes information on administration tools and utilities.
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Understanding the Redo Log
The Redo Log is a list of recoverable error messages. The application monitors all 
transactions and Workforce Management System (WMS) messages to compile the 
Redo Log.

A recoverable error occurs as a result of an incorrect transaction. A transaction may 
cause a recoverable error for a number of reasons, for example, when:

n The item record is missing required data

n The status of the item record is incorrect

n The transaction requires an item that has an incomplete transaction status

n The transaction has been initiated but requires some additional user action to be 
completed

Any WMS messages subsequent to the Incomplete transaction that are related to the 
same item are also saved on the Redo Log.

Transaction Status Recoverable (R) or Incomplete (I)
When a transaction is incomplete, it has a status of either Incomplete (I) or 
Recoverable (R).

If the transaction status is Recoverable, then Network Logistics cannot perform the 
transaction because of a recoverable error. A recoverable error may be caused by: 

n An undefined attribute, such as a missing asset category

n A pre-existing incomplete transaction for the item that prevents a second 
transaction

n A transaction that requires a quantity of item that exceeds the quantity 
available

When you correct the problem that caused the recoverable error and run the 
Recovery process, the status of the transaction becomes Complete (C).

When the status is Incomplete, it indicates that Network Logistics cannot perform 
the transaction because some action needs to be completed in a module outside of 
Network Logistics. When the action is performed, you can run the Recovery process 
to change the status of the transaction to Complete.
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Each Transaction Generates a Message
Every transaction of a trackable item generates a message to the application. When 
the application receives a message, it searches the Network Logistics tables for a 
record of the item. If it finds the record and all the attributes have been defined in 
the record, the transaction occurs without errors.

However, when a transaction results in an error, the related message is sent to the 
appropriate log. For example, if a Receipt-to-Project transaction of a normal item is 
missing attributes for category or location, a fatal error occurs. The message that is 
sent as a result of this transaction is sent to the Error Log.

Fatal Errors on Error Log
The Error Log is a list of messages that were sent to Network Logistics for 
transactions that caused fatal errors. Often these transactions involve items for 
which Network Logistics cannot find a record. The Error Log may also contain a 
few messages for transactions that caused recoverable errors.

For example, a fatal error occurs if a receipt transaction involves a depreciable item 
and the item location has not been defined. When a receipt transaction for a 
depreciable item generates a fatal error, each subsequent transaction of the item will 
result in a recoverable error. The receipt transaction must be corrected to prevent 
the accumulation of additional errors.

Transaction Status Complete (C)
The application changes the status of a transaction to Complete (C), when the 
following conditions are met:

n _ The transaction has not generated any errors

n _ The transaction is complete

n _ The transaction is not dependent on another incomplete transaction

See also:

n Understanding the Network Logistics Recovery Process

n Deleting a Record on the Redo Log
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Understanding the Message Dequeuer
A message dequeuer is a background process that continuously polls a queue and 
processes the items from the queue. The message dequeuer removes messages from 
the message queue on a first-in, first-out (FIFO) basis. Message queues are 
maintained by Oracle Advanced Queueing (OAQ). For information about message 
queues, see also:

n The Oracle Provisioning System Queues

n Administering the System Queues

n Managing the System Queues

You can manage the message queues in either Oracle Provisioning or Oracle 
Number Portability. Network Logistics uses the messaging system that is 
maintained in Service Delivery Platform (SDP). For more information about the 
messaging system, see Using the iMessage Studio.

When you start a message queue, a controller process automatically starts the 
dequeuers. For more information about starting and suspending a message queue, 
see:

n Oracle SDP Start

n Oracle SDP Stop
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Understanding the Network Logistics Recovery Process
Run the Recovery process to clear the Redo Log of recoverable errors. During the 
Recovery process, the application attempts to process each message in the Redo Log 
in chronological order.

Before running the Recovery process, you must suspend the inbound message 
queue dequeuer. This keeps it from recording more messages during the Recovery 
process. For information about the message dequeuer, see: Understanding the 
Message Dequeuer.

Steps
1.  Redo Log and Error Log Reports

After suspending the message dequeuer, run the Redo Log Report and the 
Error Log Report. These reports show the error messages that are currently 
pending. You may be able to correct some of the incomplete transactions on the 
Redo Log by correcting faulty item setups or providing additional data in you 
run the Recovery process, the message associated to the corrected transaction is 
removed from the Redo Log.

You may also find some recoverable errors on the Error Log Report.

See also:

n Requesting a Network Logistics Redo Log Report

n Requesting a Network Logistics Error Log Report

2. Next, the Recovery Process

After correcting transactions, run the Recovery Process, a concurrent program. 
This process attempts to:

n Reprocess all messages in the Redo Log

n Update all transactions that have a status of R

If the problem that originally caused a recoverable error has been corrected, the 
transaction status is updated to Complete (C). The Recovery process executes 
each message related to the transaction.

If the recoverable error has not been corrected, then the transaction cannot be 
completed. The transaction status remains Recoverable (R) and any subsequent 
message for the unit is not processed.

The Recovery process generates a Recovery Execution Report that displays 
those messages that still have not been processed.
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3. Repeat Until Redo Log is Cleared

At the end of the Recovery process, a notification tells you to restart the 
message dequeuer. To completely clear the Redo Log, you may need to repeat 
the Recovery process until all messages are processed successfully.

Running the Recovery Process
Use the Recovery process to clear the Redo Log of the messages that are associated 
with recoverable errors. Before you run the Recovery process, you request the 
Network Logistics Redo Log Report and the Network Logistics Error Log Report to 
find and then fix all the recoverable errors. Then the Recovery process attempts to 
process all the messages and clear the errors.

Follow these steps to run the Network Logistics Recovery Process.

Prerequisites
None.

Steps
1.  In the OP System Administrator Navigator, choose Administration > 

QueueConsole.

You may also start in the NP System Administrator responsibility.

2.  Select the Inbound Message Queue from the list of queues and click Suspend.

The Queue Status changes to Suspended.

3.  In the Network Logistics responsibility, request the Redo Log Report and the 
Error Log Report.

4.  When the reports are completed and normal, click View Output.

5.  On the Redo Log report, review each message. Identify and correct all errors 
that can be manually fixed.

These errors include missing attributes and unfinished user actions. Check the 
Error Log Report for errors that share the same message ID as the errors on the 
Redo Log Report.

6.  In the Network Logistics responsibility, navigate to Requests > Run

7.  In the Name field, choose Recovery process and click Submit.

The application assigns an ID number to your request. Use the ID number to 
find your request in the Requests window.
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8.  When the report is completed and normal, click View Output.

9.  Review the report. Identify and correct all errors that can be manually fixed.

10.  Repeat steps 2 through 9 until the Recovery Execution Report is cleared of 
messages

Considerations for Future Upgrade Paths
The following are considerations for future System-Level upgrades:

n System Profiles

n Enabled Workflows

n Employees and Security

n Multicurrency capabilities

n Customization Issues
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